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Copyright © 1999 Nortel Networks
All rights reserved. Printed in the USA. November 1999.

The information in this document is subject to change without notice. The statements, configurations, technical data, 
and recommendations in this document are believed to be accurate and reliable, but are presented without express or 
implied warranty. Users must take full responsibility for their applications of any products specified in this document. 
The information in this document is proprietary to Nortel Networks NA Inc. 

The software described in this document is furnished under a license agreement and may only be used in accordance 
with the terms of that license. A summary of the Software License is included in this document.

Trademarks
NORTEL NETWORKS is a trademark of Nortel Networks.

Optivity is a registered trademark of Nortel Networks. 

Accelar, BaySecure, BayStack, Centillion, EtherSpeed, Nodal View, Expanded View, NodalView, Optivity Campus, 
LANarchitect, RouterMan, Switch Node, System 3000, System 5000, Distributed 5000, Centillion, LattisSpan, 
SpeedView, BayStack, ANH, Threshold Manager, Quick2Config, and LattisSwitch are trademarks of Bay Networks, 
Inc.

Microsoft, MS, MS-DOS, Win32, Windows 95, and Windows NT are registered trademarks of Microsoft 
Corporation.

All other trademarks and registered trademarks are the property of their respective owners.

Restricted Rights Legend
Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph 
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013.

Notwithstanding any other license agreement that may pertain to, or accompany the delivery of, this computer 
software, the rights of the United States Government regarding its use, reproduction, and disclosure are as set forth in 
the Commercial Computer Software-Restricted Rights clause at FAR 52.227-19.

Statement of Conditions
In the interest of improving internal design, operational function, and/or reliability, Nortel Networks NA Inc. reserves 
the right to make changes to the products described in this document without notice.

Nortel Networks NA Inc. does not assume any liability that may occur due to the use or application of the product(s) 
or circuit layout(s) described herein.

Portions of the code in this software product may be Copyright © 1988, Regents of the University of California. All 
rights reserved. Redistribution and use in source and binary forms of such portions are permitted, provided that the 
above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising 
materials, and other materials related to such distribution and use acknowledge that such portions of the software were 
developed by the University of California, Berkeley. The name of the University may not be used to endorse or 
promote products derived from such portions of the software without specific prior written permission.

SUCH PORTIONS OF THE SOFTWARE ARE PROVIDED “AS IS” AND WITHOUT ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

In addition, the program and information contained herein are licensed only pursuant to a license agreement that 
contains restrictions on use and disclosure (that may incorporate by reference certain limitations and notices imposed 
by third parties).
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Nortel Networks NA Inc. Optivity® Network Management Software License 
Agreement

NOTICE: Please carefully read this license agreement before copying or using the accompanying Optivity network 
management software or installing the hardware unit with pre-enabled Optivity network management software (each 
of which is referred to as “Software” in this Agreement). BY COPYING OR USING THE SOFTWARE, YOU 
ACCEPT ALL OF THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT. THE TERMS 
EXPRESSED IN THIS AGREEMENT ARE THE ONLY TERMS UNDER WHICH NORTEL NETWORKS WILL 
PERMIT YOU TO USE THE SOFTWARE. If you do not accept these terms and conditions, return the product, 
unused and in the original shipping container, within 30 days of purchase to obtain a credit for the full purchase price.

1. License Grant. Nortel Networks NA Inc. (“Nortel Networks”) grants the end user of the Software (“Licensee”) a 
personal, nonexclusive license: a) to use the Software either on a single computer or, if applicable, on a single 
authorized device identified by host ID; b) to copy the Software solely for backup purposes in support of authorized 
use of the Software; and c) to use and copy the associated user manual solely in support of authorized use of the 
Software by Licensee. This license applies to the Software only and does not extend to Nortel Networks Agent 
software or other Nortel Networks software products. Nortel Networks Agent software or other Nortel Networks 
software products are licensed for use under the terms of the applicable Nortel Networks NA Inc. Software License 
Agreement that accompanies such software and upon payment by the end user of the applicable license fees for such 
software. 

2. Restrictions on use; reservation of rights. The Software and user manuals are protected under copyright laws. 
Nortel Networks and/or its licensors retain all title and ownership in both the Software and user manuals, including 
any revisions made by Nortel Networks or its licensors. The copyright notice must be reproduced and included with 
any copy of any portion of the Software or user manuals. Licensee may not modify, translate, decompile, disassemble, 
use for any competitive analysis, reverse engineer, distribute, or create derivative works from the Software or user 
manuals or any copy, in whole or in part. Except as expressly provided in this Agreement, Licensee may not copy or 
transfer the Software or user manuals, in whole or in part. The Software and user manuals embody Nortel Networks’ 
and its licensors’ confidential and proprietary intellectual property. Licensee shall not disclose to any third party the 
Software, or any information about the operation, design, performance, or implementation of the Software and user 
manuals that is confidential to Nortel Networks and its licensors; however, Licensee may grant permission to its 
consultants, subcontractors, and agents to use the Software at Licensee’s facility, provided they have agreed to use the 
Software only in accordance with the terms of this license.

3. Limited warranty. Nortel Networks warrants each item of Software, as delivered by Nortel Networks and properly 
installed and operated on Nortel Networks hardware or other equipment it is originally licensed for, to function 
substantially as described in its accompanying user manual during its warranty period, which begins on the date 
Software is first shipped to Licensee. If any item of Software fails to so function during its warranty period, as the sole 
remedy Nortel Networks will at its discretion provide a suitable fix, patch, or workaround for the problem that may be 
included in a future Software release. Nortel Networks further warrants to Licensee that the media on which the 
Software is provided will be free from defects in materials and workmanship under normal use for a period of 90 days 
from the date the Software is first shipped to Licensee. Nortel Networks will replace defective media at no charge if it 
is returned to Nortel Networks during the warranty period along with proof of the date of shipment. This warranty 
does not apply if the media has been damaged as a result of accident, misuse, or abuse. The Licensee assumes all 
responsibility for selection of the Software to achieve Licensee’s intended results and for the installation, use, and 
results obtained from the Software. Nortel Networks does not warrant a) that the functions contained in the software 
will meet the Licensee’s requirements, b) that the Software will operate in the hardware or software combinations that 
the Licensee may select, c) that the operation of the Software will be uninterrupted or error free, or d) that all defects 
in the operation of the Software will be corrected. Nortel Networks is not obligated to remedy any Software defect 
that cannot be reproduced with the latest Software release. These warranties do not apply to the Software if it has been 
(i) altered, except by Nortel Networks or in accordance with its instructions; (ii) used in conjunction with another 
vendor’s product, resulting in the defect; or (iii) damaged by improper environment, abuse, misuse, accident, or 
negligence. THE FOREGOING WARRANTIES AND LIMITATIONS ARE EXCLUSIVE REMEDIES AND ARE 
IN LIEU OF ALL OTHER WARRANTIES EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION 
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Licensee is 
responsible for the security of its own data and information and for maintaining adequate procedures apart from the 
Software to reconstruct lost or altered files, data, or programs.
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4. Limitation of liability. IN NO EVENT WILL NORTEL NETWORKS OR ITS LICENSORS BE LIABLE FOR 
ANY COST OF SUBSTITUTE PROCUREMENT; SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES; OR ANY DAMAGES RESULTING FROM INACCURATE OR LOST DATA OR LOSS OF USE OR 
PROFITS ARISING OUT OF OR IN CONNECTION WITH THE PERFORMANCE OF THE SOFTWARE, EVEN 
IF NORTEL NETWORKS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT 
SHALL THE LIABILITY OF NORTEL NETWORKS RELATING TO THE SOFTWARE OR THIS AGREEMENT 
EXCEED THE PRICE PAID TO NORTEL NETWORKS FOR THE SOFTWARE LICENSE.

5. Government Licensees. This provision applies to all Software and documentation acquired directly or indirectly 
by or on behalf of the United States Government. The Software and documentation are commercial products, licensed 
on the open market at market prices, and were developed entirely at private expense and without the use of any U.S. 
Government funds. The license to the U.S. Government is granted only with restricted rights, and use, duplication, or 
disclosure by the U.S. Government is subject to the restrictions set forth in subparagraph (c)(1) of the Commercial 
Computer Software––Restricted Rights clause of FAR 52.227-19 and the limitations set out in this license for civilian 
agencies, and subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause of DFARS 
252.227-7013, for agencies of the Department of Defense or their successors, whichever is applicable.

6. Use of Software in the European Community. This provision applies to all Software acquired for use within the 
European Community. If Licensee uses the Software within a country in the European Community, the Software 
Directive enacted by the Council of European Communities Directive dated 14 May, 1991, will apply to the 
examination of the Software to facilitate interoperability. Licensee agrees to notify Nortel Networks of any such 
intended examination of the Software and may procure support and assistance from Nortel Networks.

7. Term and termination. This license is effective until terminated; however, all of the restrictions with respect to 
Nortel Networks’ copyright in the Software and user manuals will cease being effective at the date of expiration of the 
Nortel Networks copyright; those restrictions relating to use and disclosure of Nortel Networks’ confidential 
information shall continue in effect. Licensee may terminate this license at any time. The license will automatically 
terminate if Licensee fails to comply with any of the terms and conditions of the license. Upon termination for any 
reason, Licensee will immediately destroy or return to Nortel Networks the Software, user manuals, and all copies. 
Nortel Networks is not liable to Licensee for damages in any form solely by reason of the termination of this license.

8. Export and Re-export. Licensee agrees not to export, directly or indirectly, the Software or related technical data 
or information without first obtaining any required export licenses or other governmental approvals. Without limiting 
the foregoing, Licensee, on behalf of itself and its subsidiaries and affiliates, agrees that it will not, without first 
obtaining all export licenses and approvals required by the U.S. Government: (i) export, re-export, transfer, or divert 
any such Software or technical data, or any direct product thereof, to any country to which such exports or re-exports 
are restricted or embargoed under United States export control laws and regulations, or to any national or resident of 
such restricted or embargoed countries; or (ii) provide the Software or related technical data or information to any 
military end user or for any military end use, including the design, development, or production of any chemical, 
nuclear, or biological weapons.
9. General. If any provision of this Agreement is held to be invalid or unenforceable by a court of competent 
jurisdiction, the remainder of the provisions of this Agreement shall remain in full force and effect. This Agreement 
will be governed by the laws of the state of California.
Should you have any questions concerning this Agreement, contact Nortel Networks, 4401 Great America Parkway, 
P.O. Box 58185, Santa Clara, California 95054-8185.
LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS AGREEMENT, UNDERSTANDS IT, AND 
AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. LICENSEE FURTHER AGREES THAT THIS 
AGREEMENT IS THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN NORTEL NETWORKS AND 
LICENSEE, WHICH SUPERSEDES ALL PRIOR ORAL AND WRITTEN AGREEMENTS AND 
COMMUNICATIONS BETWEEN THE PARTIES PERTAINING TO THE SUBJECT MATTER OF THIS 
AGREEMENT. NO DIFFERENT OR ADDITIONAL TERMS WILL BE ENFORCEABLE AGAINST NORTEL 
NETWORKS UNLESS NORTEL NETWORKS GIVES ITS EXPRESS WRITTEN CONSENT, INCLUDING AN 
EXPRESS WAIVER OF THE TERMS OF THIS AGREEMENT.
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Introduction

This document describes the latest information about the Optivity Campus™ 7.0.2 
network management application. This document is a supplement to your Optivity 
Campus documentation set. It is recommended that you read these notes before 
installing and using Optivity Campus.

The following information is included:

• “New Features” on page 2

• “System Requirements” on page 3

• “New Device Support” on page 4

• “Agent Support” on page 6

• “Operating System Support” on page 9

• “Operational Notes” on page 10

• “Hard-Copy Technical Manuals” on page 41

• “How to Get Help” on page 42

• “How to View Optivity Campus Documents” on page 42

Note: The Optivity Campus 7.0.2 documentation is supplied in Adobe 
Acrobat format on the Optivity Campus 7.0.2 Documentation CD. To access 
the Optivity Campus and related documents on the web, see page 42. 
Additionally, refer to the Using the Documentation CD for more information 
about accessing the Optivity Campus 7.0.2 documentation.
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New Features

Optivity Campus 7.0.2 provides the following new features:

• Year 2000 compatibility.

• New Nortel Networks device support, see page 4.

• New Nortel Networks device agents, see page 6.

• Upgraded Nortel Networks device management software, including: 

— SpeedView™ 4.1.1 for managing Centillion™ and Model 5000BH 
switches and monitoring and controlling network traffic.

— Quick2Config™ 1.3.2 for configuring Centillion router agents.

— Device Manager 3.0 and VLAN Manager 3.0 for installing and 
configuring Accelar™ routing switch products.
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System Requirements

Before you install Optivity Campus 7.0.2 and HP OpenView for Windows, ensure 
that the network management station(s) upon which you install software meets the 
requirements defined in Table 1.

Table 1. Optivity Campus 7.0.2 System Requirements

Description Requirement

Management Station Pentium IBM-compatible PC operating at 333 MHz 
recommended, 166 MHz minimum.

RAM 128 MB recommended, 64 MB minimum

Disk Space • 20 MB for HP OpenView Workgroup Node Manager 7.2d 
recommended, 10 MB minimum

• 125 MB for Optivity Campus 7.0.2 recommended, 115 
minimum

Video Adapter VGA or Super VGA adapter and display

Operating Environment • Microsoft® Windows 95®

• Windows NT® 4.0 with Service Pack 4 or 5

Communications Stack • Winsock implementation on Microsoft TCP/IP stack.
• IPX stack is supported only under Windows 95.

Network Management 
Platform

• HP OpenView Workgroup Node Manager 7.2d for Windows 
95 and Windows NT 4.0

• HP OpenView Network Node Manager 6.0 for Windows NT 
4.0

• Tivoli TME 10 NetView 5.1 for Windows NT 4.0

CD-ROM Drive 8 X recommended, 2 X minimum

Mouse Microsoft Windows-compatible
896-007-N 3
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New Device Support

Optivity Campus 7.0.2 for Windows offers network management support for the 
following new Nortel Networks devices:

• Accelar™ 8132TX Edge Switch Module

• BayStack™ 254/255 Unmanaged Stackable Hubs

• BayStack 310-24T 10 Mbps Ethernet Switch

• BayStack 350-12T/24T 10/100 Mbps Switches (Nortel Rev. D versions)

• BayStack 410-24T 10 Mbps Stackable Switch

• BayStack 450-12T/24T10/100 Mbps Stackable Switches (Nortel Rev. D 
versions) 

• BayStack 450-12F Switch

• Centillion™ 20 Token Ring Workgroup Switch

• Model 5424 EtherSpeed™ 24-Port 100BASE-FX Switch Module for System 
5000BH
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The new supported devices and the Optivity Campus applications that support 
them are shown in Table 2.

Table 2. New Devices Support by Application

Nortel Networks Devices
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Accelar 8132TX X X

BayStack 254/255 X X X X X X X

BayStack 310-24T X X X X X X X X X

BayStack 350 12T/24T Rev. D X X X X X X X X X

BayStack 410-24T X X X X X X X X X

BayStack 410 Rev D X X X X X

BayStack 450 12T/24T Rev. D X X X X X X X X X

Centillion 20 X X X X X X X X X

Model 5424 X X X X X X X X X
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Agent Support

Table 3 lists the most current SNMP agent software versions and the associated 
image and configuration template files supported by Optivity Campus 7.0.2. The 
table also indicates the agent type—standard, advanced, or advanced analyzer.

Table 3. Nortel Networks Device Agent Support

Agent Software
Standard
Agent

Advanced
Agent

Advanced 
Analyzer 
Agent

Image File
Configuration
File

Model 810M version 1.0.4 X 810m104.img 810m104.cfg

Model 271 version 4.4.0 X 271x440.img 271x440.cfg

Model 271x version 5.1.6 X 271x516.img tr516.cfg

Model 271xSA version 2.0.0 X 271sa200.img 271sa200.cfg

Model 2810 version 3.30 X b2810x33.img b2810x33.cfg

Model 2810 version 4.0 X 2810x40.img 2810x40.cfg

Model 281x version 5.3.3.7 X X 281x5337.img 281x5337.cfg

Model 281xSA version 2.0.0 X 281sa200.img 281sa20.cfg

Model 331x version 5.3.3.7 X X 331x5337.img 331x5337.cfg

Model 331xA version 5.3.3.2 X X 331a5332.img 331a5332.cfg

Model331xS version 5.3.3.2 X 331s5332.img 331s5332.cfg

Model 331xSA version 2.0.0 X 331sa200.img 331sa200.cfg

Model 3410 version 2.0.0 X 3410_200.img 3410_200.cfg

Model 351x version 4.4.1 X 351x441.img 351x441.cfg

Model 351x version 5.1.6K X 351x516k.img tr516.cfg

Model 351xSA version 2.0.0 X 351sa200.img 351sa200.cfg

Model 5310 version 1.5.1 X 5310_151.img 5310_151.cfg

Model 5310A/SA version 
2.0.1.1

X 531a2011.img 531a2011.cfg

Model 5510 version 2.0.0.1 X 55102001.img 55102001.cfg

Model 5616 version 1.5.3 X 5616_153.img 5616_153.cfg

Model 5660 version 3.0.0 5660_300.img

Model 5665 version 3.0.0 5665_300.img

Model 5620 version 3.0.0 5620_300.img
6 896-007-N
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Distributed 5000 Model 
5DN310 NMM version 2.0.0.3

X 53dn2003.img 53dn2003.cfg

Distributed 5000 Model 
5DN310 DCM version 2.0.0

nl11_200.img

Distributed 5000  2 Slot 
Chassis Host Firmware 
version 1.3.0

5d02_130.img

Distributed 5000 3 Slot Chassis 
Host Firmware version 1.3.0

5d03_130.img

BayStack Ethernet Workgroup 
Switch 
(6 port) version 3.2.9

ewg6s329.zip*

BayStack Ethernet Workgroup 
Switch 
(7 port) version 3.2.9

ewg7s329.zip*

BayStack 102 Standard Agent 
NMM version 2.0.0 

X bbse_200.img bbse_200.cfg

BayStack 103 Advanced Agent 
NMM version 2.0.0 

X abse_200.img abse_200.cfg

BayStack 104 Advanced 
Analyzer Agent NMM version 
2.0.0 

X sbse_200.img sbse_200.cfg

BayStack 104 DCM Agent 
version 2.0.0

X ln11_200.img

BayStack 100BASE-T Ethernet 
NMM version 2.0.0.2

100b2002.img 100bt200.cfg

BayStack 150 Series version 
3.0.2

b15x_302.img b15x_302.cfg

BayStack 200 Series version 
3.1.0

bs200310.img bs200310.cfg

BayStack 250 Series version 
3.2.0

b25x_321.img b25x_321.cfg

BayStack 301 version 2.1.0 exx21010.301

BayStack 302 version 2.1.0 b302_210.img

BayStack 303 version 2.1.0 b303_210.img

Table 3. Nortel Networks Device Agent Support (continued)

Agent Software
Standard
Agent

Advanced
Agent

Advanced 
Analyzer 
Agent

Image File
Configuration
File
896-007-N 7



Release Notes for Optivity Campus 7.0.2

book.fm  Page 8  Monday, November 8, 1999  2:36 PM
BayStack 304 version 2.1.0 b303_210.img

BayStack 310 version 1.1 bs310_11.img

BayStack 350T, 350F, 
350THD, 350FHD 
version 2.0.4

b350_204.img

BayStack 350-12T, 350-24T 
version 1.3.1.2

b3501312.img

BayStack 410 version 1.3.0.2 b4101302.img

BayStack 450-12T, 450-12F, 
450-24T
version 1.3.1.2

b4501312.img

BayStack Token Ring 502  
Standard Agent NMM version 
1.2.6

X bst_126.img bst_126.cfg

BayStack Token Ring 503 
Advanced Agent NMM version 
1.2.6

X abst_126.img abst_126.cfg

BayStack Token Ring 504 
Advanced Analyzer Agent 
version2.0.0

X sbst_200.img sbst_200.cfg

BayStack Token Ring 504 
DCM version 2.0.0

X n511_200.img

Model 281xx version 2.1.1.3 28k2113.img 

Model 282xx version 2.1.1.3 dds2113.img

Model 58xxx version 2.1.1.3 58k2113.img

Model 5720M version 4.1.1 axv41100.bh

Model 5724M version 4.1.1 axv41100.bh

Centillion 20 txf20100.c20

Centillion C50 version 4.1.1 axv41100.100

Centillion C100 version 4.1.1 axv41100.100

Accelar 1108, 1216 **

Accelar 1100, 1200 **

Table 3. Nortel Networks Device Agent Support (continued)

Agent Software
Standard
Agent

Advanced
Agent

Advanced 
Analyzer 
Agent

Image File
Configuration
File
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*The following comments apply to the image file used for the BayStack Ethernet Workgroup Switch (7-port) 
version 3.29. This image file is included in a .ZIP file which you unpack to a separate directory using the 
PKUNZIP utility. Once unpacked, carefully read the README.TXT file for instructions on how to 
download the image file. You can use the image file, unpacked from the EWG7S329.ZIP file, with the 
BayStack Ethernet Workgroup 7-Port Switch and not with the BayStack Ethernet Workgroup 6-Port Switch.

**The device agent must be compatible with the Device Manager application version.

Operating System Support

Optivity Campus 7.0.2 with HP OpenView Workgroup Node Manager 7.2d runs 
under both Windows 95 and Windows NT Workstation version 4.0. Optivity 
Campus 7.0.2 with HP OpenView Network Node Manager 6.0 and/or Tivoli TME 
10 NetView 5.1 runs under Windows NT 4.0 only.

Microsoft TCP/IP protocol is supported under Windows NT 4.0 only. When you 
run Optivity Campus 7.0.2 on Windows 95 or Windows NT Workstation version 
4.0, you must disable Dynamic Host Configuration Protocol (DHCP). 

Internetwork Packet Exchange (IPX) protocol is supported by Optivity Campus 
7.0.2 with OpenView Workgroup Node Manager 7.2d running under Windows 95. 
If you remove IPX after installing Optivity Campus 7.0.2, you must reinstall 
Optivity Campus or modify the configuration files.

Accelar 1050, 1051 **

Accelar 8132TX **

Note: Optivity Campus 7.0.2 does not include agent image files for Nortel 
Networks products. To obtain agent images, you must enroll in the Nortel 
Networks Software Services program. For more information, contact Nortel 
Networks Software Subscription Services at one of the following telephone 
numbers:

1-800-736-2666 (North America) or 1-408-450-3666 (International).

Table 3. Nortel Networks Device Agent Support (continued)

Agent Software
Standard
Agent

Advanced
Agent

Advanced 
Analyzer 
Agent

Image File
Configuration
File
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Operational Notes

The following sections describe key information that you should know about 
using Optivity Campus 7.0.2 on your management station.

Installation

The following notes pertain to Optivity Campus 7.0.2 installation issues:

• The Optivity Campus 7.0.2 Software CD automatically starts the setup 
program after the CD is inserted if Autorun is enabled. On some computers, 
the Windows Autorun feature either has been disabled or does not function 
properly. If the setup program does not start after about a minute, either start 
the setup program manually as described in Getting Started with Optivity 
Campus 7.0.2 for HP OpenView Network Node Manager or Getting Started 
with Optivity Campus 7.0.2 for HP OpenView Workgroup Node Manager and 
Tivoli TME 10 NetView, or refer to your computer system documentation for 
instructions on enabling the Autorun feature.

• When you reinstall or upgrade Optivity Campus 7.0.2 the following message 
is displayed:

Do you want to save old Database files?

If you answer Yes, the Optivity setup program saves your old database files in 
the opt\saved directory.

Refer to Using Optivity Campus 7.0, Appendix C, “Using the Database 
Maintenance Tool,” section “Restoring a Backed Up Database.” (This 
document is located on the Optivity Campus 7.0.2 Documentation CD.)

• If you installed Optivity Campus in its default directory, you can use the 
following DOS commands to back up the database:

cd C:\opt\db

erase *.taf

erase *.log

backup *.* a:/s

• Optivity Campus 7.0 is fully upgradeable to 7.0.2. You do not need to remove 
the Campus 7.0 software to perform this upgrade.
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• During the upgrade, the following error message maybe displayed:

“Setup could not clean up existing Application Directories 
Please remove <directoryname> from your system” check the 

following:

If you see this message, do the following:

a. Close all programs and restart your system before continuing the 
upgrade.

b. If old Optivity directories were manually deleted choose a different 
location to install Optivity.

c. If you are an advanced user, remove the “ccc.exe” entry in the 
Registry HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
Windows\CurrentVersion\AppPaths

• When you are running the setup program, select the Registration files and 
Optivity options.

• When you upgrade from a previous version of Optivity Campus to 
version 7.0.2, you should manually restore the previously saved Optivity 
database. To restore the database, copy all of the files from the \opt\saved 
directory to the \opt\db directory.

• The error messages, DBLayer Error -23, DBLayer Error -26, and DBLayer 
Error -40 could indicate that the database transaction file (vista.taf) and the 
log files (user*.log) in the Optivity database directory have been corrupted. 
To correct this problem, perform the System Cleanup procedure described in 
Chapter 3 “System Cleanup” on page 2of Getting Started with Optivity 
Campus 7.0.2 for HP OpenView Workgroup Node Manager. 

• During installation, you must provide a gateway (discovery seed router) IP 
address. In a routerless environment, enter the gateway IP address 1.1.1.1. 
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General

The following general notes apply to a variety of Optivity applications:

• Optivity Campus 7.0.2 supports up to 80 subnets and 250 manageable devices 
defined for the monitored network. 

• During IPX discovery, Optivity uses the attached IPX server to do discovery. 
If the database is not complete, set the following variable in the discover.ini 
file:

TryAltServers=1

• The BayStack 150 is not a multisegment device. However, it does let you 
isolate individual units from the segment. To isolate a unit from the segment, 
use Expanded View to open a Show Profile window for the unit and set the 
Attachment Point parameter to 0. To reconnect a BayStack 150, set the 
Attachment Point back to 1.

• You must equip Model 5505P host modules with Model 559 daughterboards 
to be recognized by Ring Manager and by the FPU table.

• Access Node Hub (ANH™) devices initialize the repeater MIB to 0xFF 
instead of 0. Thus, invalid numbers appear in the fields of the Repeater MIB 
Diagnostics display shown in Figure 5-19 in Chapter 5, “Monitoring Your 
Network,” of Using Optivity Campus 7.0 (located on the Optivity Campus 
7.0.2 Documentation CD).

• When a Model 559 daughterboard is connected to a Model 5505P module, 
LANarchitect™ shows the Model 559 device as port 21 on the network 
management module (NMM).

• In a routing environment, Optivity Campus 7.0.2 does not support multiple 
networks on a single router interface (a practice known as multinetting).

• In historic line charts, when a display is zoomed in range, all points in the 
graph with values greater than the zoom range are normalized. To view the 
actual value of all the points, increase the zoom range.

Note: Isolating a BayStack 150 Series hub using the Attachment Point 
parameter disables all management functions except the setting of the 
Attachment Point parameter.
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• If you have isolated a cluster for troubleshooting purposes, by definition you 
have prevented it from communicating. Thus, if you use Expanded View to 
monitor an isolated cluster, there is no connectivity information available for 
this cluster—only unit, slot, and port information is displayed.

• If a database error (DBLayer) occurs when you start Optivity Campus, this 
error could indicate that your hard disk is full, and the database could not be 
written. Free up hard disk space and restart the system.

• If you run an application that uses Windows Sockets (WinSock) on a 
Windows 95 workstation, a gradual increase in the memory used by the 
operating system might occur over time, especially if the program opens and 
closes a large number of sockets. You can free the resources associated with a 
program by exiting the program. If you exit and restart Windows 95, the 
memory is freed. 

• Nortel Networks recommends that you use a PostScript printer when printing 
from Optivity Campus applications. Also, Optivity Campus does not support 
the Print to File feature.

• For the IP Trap Receiver table registration to occur on a BayStack Ethernet 
Workgroup Switch, the agent must be set to default factory settings (such as 
“Read/Write community string=Private”) and Optivity Campus 7.0.2 must 
have DEFAULT=Private in the c:\opt\bin\cpasswd.ini file (the default setting 
for Optivity Campus 7.0.2).

• In some network configurations with a mix of Nortel Networks and Cisco 
Systems routers, the HP OpenView Network Node Manager alarm log reports 
error messages regarding duplicate MAC addresses. This problem is caused 
by the different brands of routers storing MAC addresses differently in their 
respective ARP caches.
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Platform Software

The following sections contain operational notes regarding the network 
management platform software supported by Optivity Campus 7.0.2—HP 
OpenView Workgroup Node Manager, HP OpenView Network Node Manager, 
and Tivoli TME 10 NetView.

HP OpenView Workgroup Node Manager

• HP OpenView D.01.02, version 7.2 supports variable length subnet mask 
configurations. However, Optivity Campus 7.X does not support this feature 
and will not discover any devices in the network using variable subnet masks.

• When an Accelar 1100 or Accelar 1200 switch is included on an HP 
OpenView map, OpenView may fail upon receiving traps from the Accelar 
device. This problem occurs because the Accelar routing switches send 
SNMP v2 traps by default, and OpenView can only handle SNMP v1 traps. To 
prevent this problem, configure the Accelar device as follows to send SNMP 
v2 traps:

In the Accelar Device Manager application, choose Edit > Chassis and click 
on the Trap Receivers tab. Then, find the entry for the Optivity Campus 
management station in the Trap Receivers list and change the Version entry 
from V2 to V1.

• If the HP OpenView Workgroup Node Manager History list of traps is 
allowed to grow too large (greater than about 25000 entries), opening the 
History list can stop the computer. Stopping OpenView using the Windows 
Task Manager or Close Program dialog box in this situation can corrupt the 
alarm database, which prevents OpenView from starting. To prevent this 
problem, use the HP OpenView Customize Alarms dialog box to configure 
OpenView to delete alarms before the History list grows too large. Note that 
Acknowledging traps does not delete them; it moves them into the History 
part of the Alarm Log. 

• During the installation, Optivity 7.0.2 makes some modifications to your 
existing HP OpenView Workgroup Node Manager (OpenView 7.2d) .ini and 
devices files. Optivity 7.0.2 creates a backup copy of the .ini and devices files 
(for example, devices.001, devices.002) in the c:\opt\saved directory. Use the 
saved files to return customization to your .ini files. (Note, however, that 
Optivity 7.0.2 does not maintain the original backup copies of your 
trapmgr.ini and ovwin.ini files if you install Optivity.)
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• Optivity Campus 7.0.2 is supported on HP OpenView D.01.02 that is shipped 
on the installation CD. If you have a different version, uninstall it prior to 
installing Optivity Campus 7.0.2.

• The following error message may display if you open and then close Optivity 
Campus within less than one minute: Exit Optivity first before 
logging in again. This error happens because the logout and login 
processes take more than 30 seconds to execute. To avoid this problem, wait 
at least one minute after you log out of Optivity before you log back into or 
restart Windows.

• If you double-click an icon on the HP OpenView map and the submap does 
display, do the following:

— Choose Windows > Locate Object.

— Select a device that is part of the map that could not be displayed.

— Choose Edit > Rename Submap.

— Delete the DOT at the end.

• If HP OpenView faults with an OVNETMON error, exit OpenView and 
reboot your system.

• When you use the HP OpenView polling feature, you may receive an Out of 
Buffer Condition error. This error occurs in the Windows 95 environment 
if all of the following conditions exist:

— The Optivity station is included in the polling list.

— The Optivity station is set as the default gateway.

To correct this problem, remove the Optivity station from the polling list.

• In a switching environment, the color of a device symbol for an Advanced 
agent NMM on the HP OpenView map might not reflect current device status. 
To ensure that accurate symbol colors are displayed on the map, add the 
Advanced agent NMMs you are managing to the HP OpenView polling list 
and start the polling process.

• If you see the OVWIN caused a GPF in module <unknown> message, 
shut down and reboot the system. Then delete the following files:

C:\OPT\DB\*.taf and *.log
C:\*.net
C:\OPT\OV\*.lck and ovalins.*
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• If the SNMPAltRouterCommunity= parameter is set in the OVWIN.INI file, 
the OpenView discovery process uses this parameter and excludes the 
SNMPDefaultCommunity= parameter.

• Do not change the OpenView subnet map name for compound objects (such 
as segment or subnet symbols). The subnet map name and compound object 
name must be the same in order for OpenView to open the subnet map when 
you double-click the compound object.

• When you use the HP Openview SNMP compiler to compile a MIB file that 
contains other MIB files and receive the following compiler error:

The selected files depend on the following MIB file: 
<list of MIB files>. Please compile these MIB files 
before attempting to compile this selection.

Check the following for possible causes.

— The selected MIB file has a dependency on one or more of the MIB files 
listed.

— Check the MIB files contents for correct format.

— Select all MIB files that have dependencies at the same time before 
compiling or adding them to the database.

• The Optivity Campus database synchronization overwrites the host name 
field with an IP address which creates the same object twice in the HP 
OpenView database. A workaround is to select the hostname from the menu 
bar, by choosing Autodiscovery > Discover > Update.

HP OpenView NNM and Tivoli TME 10 NetView

The following operational notes pertain to issues related to both HP OpenView 
Network Node Manager and Tivoli TME 10 NetView:

• Original registration files stored in the following locations are saved to <NMS 
platform>\saved prior to updating them with Nortel Networks entries:

— <NMS platform>\conf

— <NMS platform>\device

— <NMS platform>\fields 

These files are overwritten by files currently in use every time you perform 
the installation process. However these files are not removed by the uninstall 
process, so you must restore them to their original location after an uninstall.
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• You can start or exit Campus Command Center (CCC) independently of 
HPOV NNM or NetView.

However, you should never close or use Windows Task Manager to stop 
Optivity Campus processes.

• Check the PATH environment variable before you start NNM or NetView for 
the first time after installing Optivity 7.0.2. Follow the guidelines in Getting 
Started with Optivity Campus 7.0.2 for HP OpenView Network Node Manager 
and Tivoli TME 10 NetView to verify and restore, if needed, the PATH 
variable to its correct value.

• The Optivity Campus installation for NNM opens the NNM console during 
the registration process. You may clear and close it to resume installation.

• Towards the end of the installation process, cmd windows pop up 
momentarily as the setup program updates the platform databases. This may 
take quite some time depending on the size of the current NNM or NetView 
database. However, if any of these processes appear to be hung for an 
unreasonable length of time, you may stop them and manually perform the 
update later. 

To manually update the platform database, execute the following commands 
in the order given.

Note: If the computer hangs after you issue the ovstop command, open 
the Windows NT task manager and end all processes named ov*.exe (such as 
ovtrapd.exe).
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— For Tivoli TME 10 NetView

ovstop netmon

ovw_config

ovstop

ovstart ovwdb

ovstart ovtopmd

ovtopofix -a

ovstart

— For HP OpenView Network Node Manager

ovstop

ovstart ovwdb

ovw -fields

ovstart ovtopmd

ovstop netmon

ovtopofix -a

ovstart

• You should configure NetView and Network Node Manager to check for 
essential daemons at frequent intervals and restart them, if necessary. Failure 
of Netmon, which may occur because of some other associated process failed, 
prevents Campus Command Center and other related applications from 
receiving traps. Furthermore, TrapRdr32, the interface between NetView and 
Optivity, gets into a loop waiting for traps from the platform and takes up a 
very high percentage of CPU time.

Agent Software

The following operational notes pertain to issues related to agent software that are 
general in nature or exhibit symptoms in more than one Optivity Campus 
application:

• The Model 331X version 5.2 agent does not display any data in the utilization 
and frame size graphs in the RMON Summary window. In Report Manager, 
the packet, octet, and utilization graphs are displayed as 0. To solve these 
problems, use agent version 5.3 or later.
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• All segment-level pop-up pie charts and displays for a Distributed 5000™ or 
BayStack Ethernet Hub are either “0” or return an “Invalid Object” message 
on the pop-up status line.

• For the Distributed 5000, BayStack Ethernet, and BayStack 100BASE-T 
hubs, the Show Profile display is unable to show the Location, Name, 
Version, Contact, and Description MIB object information.

Specifically, when SNMP requests are performed with group #1 index (Board 
index and Interface Number) on Distributed 5000 and BayStack Ethernet 
hubs, the agent returns an “Invalid Object” message. Additionally, when 
SNMP requests are performed with group #8 index (Ethernet and Segment 
Number), the agent returns a value of zero for backplane segment numbers 1, 
2, and 3. For backplane segment numbers greater than 3, the agent returns an 
“Invalid Object” message.

• Token ring agents do not ping the router. As a result, IP hub discovery may 
not discover the IP addresses of representative NMMs in your token ring 
subnets. If this is the case, use the Add Device feature to manually add them.

• After you upgrade an agent in a device, Optivity Campus 7.0.2 does not 
reflect the correct agent version until you update the database. To update the 
Optivity Campus database, in Expanded View of the device, choose 
Configure > Validate.

DEVPOL Polling

After a default installation, the Optivity specific device poller DEVPOL performs 
all polling activity in Optivity Campus. The Optivity specific poller includes 
several enhancements in this release. These enhancements and some known issues 
regarding those enhancements are described in the sections that follow.

Default Device Classes Polled

Formerly, in Optivity Campus 7.01, only the Hub device class was actively polled 
after performing OpenView discovery and subsequent layout of a map. The new 
DEVPOL in Optivity Campus 7.0.2 additionally polls Router and Switch device 
classes as well. 
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Known Issues

While you can see this additional polling activity after creating the initial 
OpenView map, a problem was found when you save, close, then reopen the 
initial map. This activity causes the Optivity specific poller to revert back to 
Optivity Campus 7.01 behavior (polling only the Hub device class). 

For the problem regarding DEVPOL reverting back to Optivity Campus 7.0.1 
polling behavior, use the following suggested workaround:

1. Start Campus Command Center (CCC) discovery and open a CCC view. 

All devices and device classes contained in the CCC views are added to the 
polling list and are polled automatically by DEVPOL. Be sure to reopen a 
CCC view each time you restart Optivity Campus. 

2. If not using a CCC view, use the Refresh button (a new feature in this 
release) within DEVPOL to generate a new list of devices to be polled 
from the active OpenView map.

To use the Refresh button, right-click the DEVPOL icon in the Windows 
taskbar and choose Modify Poll List. From the DEVPOL window, click 
Refresh. 

After a refresh, all devices and device classes present in the active OpenView 
map are actively polled (see, DEVPOL Refresh Button, Known Issues next). 
Perform a refresh each time you restart Optivity Campus after closing and 
reopening an OpenView map.

DEVPOL Refresh Button

The Refresh button causes DEVPOL to regenerate a new list of devices to be 
polled. The list is regenerated based on what particular OpenView map and/or 
CCC views are currently open.

Note: If you are experiencing a problem with all device classes being polled, 
skip to DEVPOL Refresh Button, “Known Issues” on page 21.
20 896-007-N



Operational Notes
  

book.fm  Page 21  Monday, November 8, 1999  2:36 PM
Known Issues

• If you open an OpenView map and it contains Generic IP devices (by 
definition, anything that responds to a Ping but fails to respond to an SNMP 
request), these devices are actively polled via SNMP and fail. The generic 
device icon color changes from green to red. This critical device color then 
propagates to the higher level Internetwork View map as well. 

The workaround to this problem is as follows:

1. Filter the Generic IP device class as well as any other device classes you 
do not want to manage.

From the OpenView menu, choose Autodiscovery > Configure > Device 
Classes.

2. Click the device class from the available list, then click Ignore. 

3. Perform a new Basic Layout to recreate a new map. 

The new map no longer shows the device icons from the device classes 
previously ignored. 

4. Click Refresh in DEVPOL to regenerate a new polling list based on the 
devices present in the active OpenView map. 

To use the Refresh button, right-click the DEVPOL icon in the Windows 
taskbar and choose Modify Poll List. From the DEVPOL window, click 
Refresh. 

5. Save the OpenView map.

From the HP OpenView menu, choose File > Save.

Topology 

The following notes pertain to topology issues:

• Optivity Campus 7.0.2 supports up to 250 manageable devices.

• Campus Command Center Autodiscovery does not work when an 
Accelar 1200 or Accelar 1100 routing switch is designated as the default 
gateway.

• The correct network topology may not be discovered if multiple bridges are 
connected to a network segment through a device that has Standard agent 
software installed. To correct this problem, install Advanced agents.
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• Optivity could take up to one minute to reflect topology changes for System 
3000™ devices and up to five minutes for System 5000™ devices, depending 
on network size.

IPX Protocol

Note the following points regarding the IPX protocol:

• If you want IPX support on a Windows 95 workstation, install the Microsoft 
NetWare component when you are configuring the management station.

• If you add IPX communications stacks to the management station after 
installing Optivity, reinstall Optivity to ensure that all IPX-related files are 
installed.

• If you remove IPX communications stacks from the management station after 
installing Optivity, delete the IPX references from both the [Optivity] and 
[LNMS] sections of the synopt.ini file. Find the line that reads:

Protocols = IP, IPX

and edit it to read:

Protocols = IP

On HP OpenView Workgroup Node Manager platforms, also remove 
references to the IPX protocol from the OPT\OV\OVWIN.ini file:

— In the [Discovery] section, find the line:

IPXDiscoverAll=Yes

and change it to read:

IPXDiscoverAll=No

— In the [OpenViewSNMP] section, find the line:

SNMPNetIpx=yes

and change it to read:

SNMPNetIpx=no
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Miscellaneous Problems

The following miscellaneous problems have been observed:

• On the Windows 95 platform, printing tables across the network does not 
work. However, printing tables locally is possible.

• Flatnet View displays a Topology Information Error ErrNo = 117 
message when it cannot find the representative switch in a segment. 
(CR 113016)

• In OmniView, the performance utilization percentage on a WAN segment is 
off by a factor or 100. (CR 111524)

• OmniView displays erroneous or no Ring > Activity statistics for token ring 
devices. (CR 108349)

Bugs Fixed

• The Internetwork Map in HP OpenView always stays on the top of the HP 
OpenView main window. (CR 57180)

• Eliminate the Describe Flatnet dialog box used to Describe a flat network. 
This dialog box opens if Optivity Campus cannot find a representative NMM. 
(CR 56262)

• The Node Discovery in Optivity Campus 7.0.1 does not collect Show Nodes 
data from 5000BH and Centillion MCP modules. Therefore, Find Nodes does 
not work, and you do not know the stations attached to 5000BH and 
Centillion MCP modules. (CR 103567)

• The DCS.INI file that ships with Optivity Campus 7.0 has an IP Utilization 
formula that is misleading. The formula indicates of the amount of IP Packets 
Discarded. (CR 88227)

• You can change the IP address of the management station using the Optivity 
System Preferences dialog box NMS Configuration tab. (CR 56555)

• The DEVPOL device poller includes the following functionality: (CR 
111580)

— The Save Button is functional and saves beyond the active session. This 
involves removing calls that refresh the DEVPOL list when you reset 
another OpenView map or Campus Command Center View.

— Sort the list by IP address.
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— Flush the DEVPOL list and refresh it based on the current maps/views 
open at the time. 

• Trap Registration process no longer occurs every 60 seconds. (CR 75615)

Application Notes

The following sections list operational notes and known problems for various 
Optivity Campus 7.0.2 applications. Agent-related issues are listed under 
Operational Notes of the application in which the symptoms are observed because 
they represent problems with the agent software, and not with the application.

Agent Manager

These notes pertain to the Agent Manager application.

Operational Notes

• The Agent Manager application needs both the MAC address and the IP 
address of each device to list the device in the main dialog box. Depending on 
how many devices you are upgrading, you can run Expanded View or Flat 
Network View or run Node Discovery to ensure that your database is fully 
populated.

• To show all NMM entries in Agent Manager, you must run the Optivity Node 
Discovery utility.

• When you upgrade an agent using Agent Manager, the boot router settings of 
the device must be properly configured. Otherwise, Agent Manager will not 
be able to upgrade the agent.

• The Revision column of the Image Upgrade dialog box displays the hardware 
revision letter instead of the firmware revision as stated in the documentation 
and online Help.
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Known Problems

• Agent Manager does not support BayStack 200, BayStack 250, BayStack 350, 
or BayStack 450 series devices and the Accelar 8132TX, Model 5424 
EtherSpeed 24-Port 100BASE-FX Switch Module for System 5000BH or 
Distributed 5000 Hub, Edge Switch Module, and the Centillion Token Ring 
Workgroup Switch. Refer to the documentation supplied with these devices 
for instructions on upgrading the agent software. 

• In Agent Manager, during the upgrade procedure, entering the agent key via 
the Agent Key feature causes the Image Upgrades dialog box to display the 
key. The # agent XXXXXXXX (agent key) is written to the agent 
configuration file. Open the configuration file and delete the pound symbol 
(#) from the agent key before upgrading the agent. 

• Agent Manager may not be able to recommend the correct agent image 
upgrade version for devices that cannot distinguish an agent maintenance 
release (for example, for version 5.31, 5 is the major release, 3 is the minor 
release, and 1 is the maintenance release). After you perform the upgrade, the 
Status column shows In Progress when it should display Successful. If you 
restart Agent Manager, the Image Upgrade dialog box displays agent image 
version 5.30 in the Version column instead of 5.31. It also displays 5.31 in the 
Recommendation column instead of none, even though you have successfully 
downloaded the upgraded agent image version.

Alarm Manager

These notes pertain to the Alarm Manager application.

Operational Note

• Online Help is only available for those traps that arrive after the Alarm 
Manager window is opened. For all other traps, the online Help opens to a 
listing of the available Help topics.

Known Problem

• Alarm Manager does not properly report traps received from Nortel Networks 
routers.
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Campus Command Center

These notes pertain to the Campus Command Center (CCC) application.

Operational Notes

• When many device icons turn red despite being reachable via Ping, it may 
indicate that the community strings in the device database are incorrect. This 
situation can occur if you upgraded or reinstalled Optivity, or reset the 
Optivity database, and then opened an old .ccc file. 

If this situation occurs, choose Applications > Set Community String in 
Campus Command Center, and use the Set Community Strings dialog box to 
enter all of the read community strings used on your network. Click Yes when 
the application prompts whether or not you want to discover community 
strings.

• In CCC the Applications menu lets you start generic Optivity Campus 
applications, such as Expanded View and Threshold Manager. 

Bugs Fixed

• The management station does not hang when you start Optivity Campus 7.0 
Autodiscovery against a network including multinetted router loops. 
(CR 74742)

• The Autodiscovery Scheduler tab now lets you set options and longer closes 
prematurely, causing you to lose your changes. (CR 113461)

• Optivity Campus Command Center now displays a dialog box that tells you to 
Use Device Manager/VLAN Manager for managing all Accelar devices. 
(CR 113134)
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Device Manager (For Accelar Routing Switches)

These notes pertain to the Device Manager application.

Operational Notes

• When you start Device Manager by right-clicking an Accelar device in the 
Campus Command Center Switches folder, the Open Device dialog box 
opens. You must enter the IP address of the target Accelar device in the 
Device Name text box to start the Device Manager application.

• You can not start Accelar Device Manager from the Optivity Campus 
program group or from the HP OpenView menu bar. (81623)

Expanded View

These notes pertain to the Expanded View application.

Known Problems

• When you run Expanded View on a Centillion C100 switch, the Bridge 
Groups Table (opened by choosing Config > Bridge Group) does not show 
any bridge groups for token ring modules.

• A problem occurs when you run Expanded View and then LANarchitect on a 
System 5000 device or any of the supported switching devices (Models 
281XX, 28200, or 58000). When you try to view the Expanded View window 
for the second time, the window is blank. To make the window display 
correctly, choose Config > Validate.

• When you show the profile of two different token ring NMMs in the same 
chassis the same data is displayed for both NMMs. (CR 56735)

• Expanded View shows the BayStack 450 with the Bay Networks logo instead 
of the Nortel Networks logo. (CR 108434)
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Bugs Fixed

• The BayStack 350 Autosense Switches reports LED status of the media 
dependent adapters correctly.

• The LEDs for port numbers above 12 on the Baystack 450-24T display 
correctly in Optivity Campus 7.0.1Expanded View. (CR 99235)

• Expanded View in Campus 7.0 treats the 4x4 100BASE-TX switch Net 
Module like a 16-port module. Normally, that module is 4 switched-ports 
where each presents 4 100BASE-TX interfaces (a hub in fact), so the MCP 
considers the card as 4 ports. (CR 91119)

• The Set Partition Failed error message no longer is displayed when 
you partition a port on a BayStack 450 Switch in Expanded View by 
right-clicking the desired port and choosing Fault > Partition. (CR 101053)

Flat Network View

These notes pertain to the Flat Network View application.

Operational Notes

• To show a switch in Flat Network View, you must use the Describe feature to 
enter the IP address and device type for the switch.

• In a network with Baystack 100BASE-T or 10BASE-T hubs with basic 
agents, topology may not be supported. Flat Network View may use these 
basic agents as a representative network management module (NMM), but 
these agents do not support network topology. To make topology work 
correctly, assign another agent as the representative NMM using the Describe 
feature.

• If you have a problem seeing a BayStack 28115 Ethernet Switch (formerly 
known as the LattisSwitch™ hub), a BayStack 28200 Modular Ethernet 
Switch, or a BayStack Ethernet Workgroup Switch in Flat Network View, 
make sure its MAC and IP addresses are in the device database. Start 
LANarchitect or Expanded View to ensure that your database is complete 
with both IP and MAC addresses for these switches.

• In a switching environment with Nortel Networks switches, the color of a 
device symbol in Flat Network View or Segment View may not reflect current 
device status. To correct this problem, use the Validate feature to update the 
Flat Network View or Segment View display.
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Known Problems

• Flat Network View cannot display interconnection information for switched 
networks.

• Flat Network View does not effectively support combinations of 
28100-series, 28200-series, and BayStack Ethernet Workgroup switches.

• Flat Network View does not support the Model 5616 Ethernet/Fast Ethernet 
NMM.

• Flat Network View does not show correct topology for segments that contain 
BayStack 250 devices.

• Token ring bridge icons remain blue in Flat Network View.

LANarchitect

These notes pertain to the LANarchitect application.

Operational Notes

• Although you can display a BayStack Ethernet hub in LANarchitect, the agent 
software does not support software switching for segments. However, the 
Move button is not deactivated for BayStack Ethernet hubs. For BayStack 
Ethernet hubs when you use LANarchitect to move a cluster to different 
segments, the following message is displayed:

Move Cluster - Fail to attach cluster

• In the Model 5580 Token Ring Router Module, only interface 4 supports 
LANarchitect. Interfaces 1, 2, and 3 are hardwired to ring segments 
1 through 3.

• When you use LANarchitect to move ports between backplanes on Model 
5605P or 5675P-FX Autosense host modules, observe the following:

— Each port has both 10 Mbps (Ethernet) and 100 Mbps (Fast Ethernet) 
connections. The 10 Mbps connection is the connection the port uses 
when Autosense detects that the connected device is communicating at 
10 Mbps. The 100 Mbps connection is the connection the port uses 
when Autosense detects that the connected device is communicating at 
100 Mbps.
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— When you drag ports between backplanes, LANarchitect always moves 
the port connection (either 10 Mbps or 100 Mbps) that matches the speed 
of the target backplane. The configuration of the other connection is 
determined by the settings of the AutoSense Setting dialog box, that 
opens when you choose Option > Set Config Mode. These settings are as 
follows:

• Under the Symmetrical Number setting, the other connection is 
moved to the matching backplane of the same number.

For example, dragging a port from E-Bkpl # 3 to E-Bkpl#5 moves the 
10 Mbps connection to E-Bkpl #5 and also moves the 100 Mbps 
connection to FE-Bkpl #5.

• Under the Isolate setting, the other connection is isolated.

For example, dragging a port from E-Bkpl # 3 to E-Bkpl#5 moves the 
10 Mbps connection to E-Bkpl #5 and also isolates the 100 Mbps 
connection.

• Under the Ignore setting, the other connection remains unchanged.

For example, dragging a port from E-Bkpl # 3 to E-Bkpl #5 moves 
the 10 Mbps connection to E-Bkpl #5 but does not change the 100 
Mbps connection from its previous value.

Known Problems

• You can not use LANarchitect to move a Model 28200 DCM to a different 
port on the switch.

• LANarchitect shows the BayStack 10BASE-FL hub and either the 10BASE-T 
hub AUI MDA or 10BASE-FL MDA as separate components even though 
they are in the same cluster as other ports on the same hub.

• For Model 5616SA NMMs, LANarchitect does not properly identify DCMs, 
second interfaces, or PPP interfaces. This misidentification causes the 
application to represent these resources with the magnifying glass icon 
normally used for NMMs.

• LANarchitect does not show local segments for the 53DN003 chassis. 
(CR108444)

Note: When you drag Autosense ports between backplanes of different types, 
always validate the setting from the device after each successive operation.
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Nodal View

These notes pertain to the Nodal View application.

Operational Notes

• In NodalView™, Distributed 5000 (version 1.3 and later) and BayStack 
Ethernet hub (version 1.3 and later) nodes turn blue because they do not 
support the statistics for which they are being polled. This is true for the 
Model 5310SA Agent version 1.5.1, the BayStack 100BASE-T Agent version 
1.1.1, the Model 331x Agent version 5.3.3, and the BayStack 50x Agent 
version 1.1.2.

• The Net Address (IPX) display property in NodalView is not available. Net 
Address always displays the IP address.

Known Problems

• In Nodal View when you choose Properties > Net Address, the IP addresses 
for some devices are not displayed.

The same is true in the RMON Summary View. When you select View by Net 
Address (default is MAC address), some of the devices do not display their IP 
addresses. (56865)

• In Nodal View, to partition a user from their attached port, click on the icon 
representing the user (PC) attached to a port of a managed hub, right-click on 
the line representing the PC and choose Fault > Disable. However, when you 
try to re-enable the port by choosing Fault > Enable, the process fails. The 
workaround is to enable ports through Expanded View. (CR 57447)

Node Security Manager

These notes pertain to the Node Security Manager application.

Bugs Fixed

• Node Security Manager works with BayStack 150 or BayStack 250 devices. 
This is due to problems with the BayStack 150 version 2.0 agent and the 
BayStack 250 version 1.0 agent. (CR 86950)

• Node Security for Distributed 5000 hub now works. (CR 87822)
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Out-of-Band Manager

This note pertains to the Out of Band Manager application.

• If out-of-band communication times out while modems are negotiating a 
connection, you should add the following information to the 
c:\opt\bin\async.ini file:

[Modem]
WaitConnect=44

Report Manager

These notes pertain to the Report Manager application.

Operational Notes

• Nortel Networks recommends that you routinely back up your report database 
by copying and saving the c:\opt\db\dcsdb.* files. 

• When you use Report Manager, you must always provide the RMON 
Interface Number in the “Device Details Page.”

• In Report Manager, “DCM A” may not correspond with “RMON Interface 1.” 
To determine the interface to DCM mapping, run the RMON Summary 
application on the device in question. If the interface number is not available, 
uncheck the “Select RMON agent” box and the program defaults to collecting 
information from the NMM. Data collected will then be from the segment to 
which the NMM is attached.

• When Report Manager is abnormally terminated, the following message is 
displayed when the Report Manager is restarted: DBLayer Error, 
invalid db_address (code = -6). After this error displays, a dialog 
box opens with a list of reports. Open each report to determine if data is 
accessible. If not, delete that data collection from the Report Manager.
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Known Problems

• Report Manager does not support BayStack 250 devices.

• Report Manager supports Model 5616 modules to the segment level; port 
level statistics are not supported.

• In Using Optivity Campus 7.0, on page 8-16, it says that in Report Manager 
you can choose File > Open to open a file that has been saved as a tabbed or 
HTML file. This menu does not exist.

• For the BayStack 410 switch Report Manager show specify the correct 
interface index for report collection instead of slot and port indexes. 
(CR 112700)

Bugs Fixed

• Running Optivity Campus 7.0 Report Manager against a token ring System 
5000 or Model 5510 NMM running version 2.0.0 code does not fail. 
(CR 86211)

• Report Manager only looks at the report name longer than five characters. 
(CR 57168)

• Report Manager properly sorts reports created after the year 2000. 
(CR106789)
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Ring Manager

These notes pertain to the Ring Manager application.

Operational Notes

• The following items pertain to the TR Embedded Manager window:

— For a Model 5505 token ring module, changing the value in the Mode 
column from CoreStatistics to Roving will not result in Roving appearing 
in the Mode column for all entries pertaining to that module.

Instead, one of these entries continues to display a value of CoreStatistics 
in the Mode column. It is not possible to obtain statistics for that entry. 

— For the Model 5575X token ring module, it is not possible to obtain 
accurate statistics if the RingIn port is not inserted. 

— For the Model 5502 token ring module, the EmbeddedMgmt value is not 
accurately represented in the Capabilities column. 

— If a module has “EmbeddedMgmt” capability and the mode is set to 
“CoreStatistics,” only one entry should exist for that module. If more than 
one entry is present, wait for some period of time and then validate again 
to allow the multiple entries to collapse as one. In the multiple entry state, 
it is not possible to obtain statistics for that module.
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RMON Applications

These notes pertain to the Optivity Campus RMON applications.

Operational Notes

• The Layer 3 Matrix RMON applications poll only proprietary Nortel 
(Synoptics) hubs. These applications will not work with RMON 
industry-standard devices, including Stack Probe agents. The workaround is 
to use Optivity Analysis NT 1.1.

• Because some device agent MIB profiles coded within Optivity may not have 
been updated to the most recent and capable agent for some devices. Optivity 
may assume that a device RMON capability to be less than actually exists 
with a newer agent loaded in the device. Therefore, some RMON groups 
information may not be polled by Optivity even though the device is capable 
of providing this information. The workaround is to use Optivity Analysis NT 
1.1.

• To view full RMON data for the BayStack 50x Token Ring Hub, start the 
application for the two interfaces.

• To view files you saved using the RMON Summary Filter and Capture 
feature, use pdecode.exe, located in the \opt\armon\ directory.

• When you run RMON applications for a System 5000BH chassis in which 
more than one MCP module is installed, note that each MCP module can only 
gather RMON statistics for the half of the chassis in which it is installed (slots 
2-8 or slots 9-13). Use the Probe Connectivity dialog box in the Campus 
Command Center to make sure that the IP address specified is for the MCP 
installed in the half of the chassis for which you want to gather RMON 
statistics.

• Optivity Campus RMON applications support System 5000BH modules and 
Centillion C50N and C50T switches only if they are running version 2.2 or 
later agents and the etherStatsTable has already been created. To create the 
etherStatsTable, see the following readme file on the Optivity Campus 
Software CD:

<CD_drive>:\wgn\unsupprt\readme.est
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• When you run RMON Summary on a BayStack 28000 Switch running an 
agent version 2.0 or earlier the following error is generated:

“(RMONSVR-019) There is no Probe Monitoring <IP Address>,Slot:x, 
Port: y”

As a workaround, edit the c:\opt\bin\rmon_opt.ini file and find the lines 
below:

:28K family; provide default support

1.3.6.1.4.1.45.3.15.1=0

1.3.6.1.4.1.45.3.13.5=0

1.3.6.1.4.1.45.3.17.3=0

Modify all values on each subnet line replacing “0” with “2”. If the RMON 
server process is not closed at this time, wait a few minutes until it is closed 
before restarting RMON Summary.

Known Problem

• The RMON Filter and Capture application does not work with either Stack 
Probe or with System 5000 token ring devices.

RouterMan

These notes pertain to the RouterMan™ application.

Operational Notes

• If your RouterMan Browse Profiles display for an Agent Identification Server 
shows a time out in the status bar, close RouterMan and restart the 
application.

• In RouterMan, some of the XNS Host Table and Filter Table displays may 
always show “Get” in the status bar.

• The Administration Status field for Nortel Networks routers 7.55 and above 
displays the number 1, 2, or 3, with the following meanings: 1=up, 2= down, 
and 3=testing.

• RouterMan generates an Unknown Protocol message in the fault log if the 
router receives a BOFL packet.
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Known Problems

• When RouterMan shows the administration status as up and the operational 
status as down, the fault symbol, performance symbol, and Fault Log do not 
show or report a fault.

• On a Novell file server with routing capability turned on, the SysName, 
SysLocation, and Contact Person fields cannot be set to NULL using 
RouterMan.

• In the RouterMan Fault Log, no entry is available in the “Cause” field for 
Nortel Networks routers.

• For Nortel Networks routers running the VINES protocol, the Configuration 
Routing Table displays identical values in each table entry.

Bug Fixed

• The following error messages do not occur when you start Router Man 1.2 on 
either a Windows 95 or Windows NT management station. (CR 104413)

— Error insufficient Memory

— Abnormal program termination

Segment View

These notes pertain to the Segment View application.

Operational Notes

• For some video display drivers, Segment View icons are not displayed 
properly. If this happens, it is recommended that you set your video display 
driver to 256 colors.

• Segment View does not support Model 5616 modules.

Switch Monitor

These notes pertain to the Switch Monitor application.
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Operational Notes

• The Switch Monitor calculates switch port utilization on both received and 
transmitted traffic. For unconnected switch ports, the utilization is nonzero 
because of switch maintenance traffic. For BayStack 28115 Ethernet 
Switches, the utilization is based on received traffic only.

• The following requirements must be met before the Load Balance Manager 
can properly analyze the traffic patterns among switched segments and 
provide Load Balance recommendations:

— RMON agents are required for each switch segment because the 
Load Balance Manager uses the RMON source-destination and 
destination-source matrix to analyze traffic.

— You must use the Describe feature to enter RMON into the database.

• When you run Switch Monitor for BayStack 28000- or 58000-series switches 
running in STP Mode, the Domain View and Community View are available 
even though these views are only valid when the switch is running in 
LattisSpan™ mode. In STP mode, Domain and Community views display 
invalid information.

• When you add rows to the Utilization Graph or the Error Graph for the 
BayStack Stackable Hub the row is shown as “Sx-Py” where “x” is the unit 
number and “y” is the port number.

Known Problems

• The Switch Monitor application does not support the Ethernet Workgroup 
Switch or the Baystack 301 Desktop Ethernet Switch.

• The Switch Monitor does not support versions 1.1X and 1.2X of the BayStack 
28115 Ethernet Switch agent software. Versions 1.3X, 1.4X, and all future 
releases are supported.
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• Switch Monitor does not display agent information for a BayStack 28000 
agent versions 2.1.0.x or 2.1.1.x. (CR 78606)

Bugs Fixed

• Switch Monitor now provides a switch view on 28K switch agents beyond 
version 2.1.0. (CR 78606)

• Running Switch monitor on a BayStack 350T running 1.2.0.10 code, the In 
Kilobytes statistic in the display no longer shows a negative number. 
(CR95445)

• Switch Monitor now shows all of the units in stacked BayStack 450 
Autosense switches. (CR 11079)

• Switch Monitor running on a MCP now works when the total number of 
interfaces in a Centillion/5000BH exceeds 112. (CR 100256)

Threshold Manager

These notes pertain to the Threshold Manager application.

Operational Notes

• Threshold Manager supports System 5000BH modules and Centillion C110 
and C50 switches only if they are running version 2.2 or later. These agents do 
not populate the “etherStatsTable”, “tokenRingMLStatsTable”, and 
“tokenRingPStatsTable” tables automatically. To populate the table, see the 
following readme file on the Optivity Campus 7.0.2 Software CD:

<CD_drive>:\wgn\unsupprt\readme.est

• The Centillion agent version 3.1 and above have “tokenRingPStatsTable” 
support.

• The Threshold Manager menu item is enabled only for certain devices. It is 
not available for all devices.

• On the BayStack 28000 and 58000 Switches the Threshold Manager only 
supports agent version 2.1 and later.
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Known Problems

• When you run Threshold Manager on a Model 3410 NMM, the Event Log 
tool bar is always deactivated.

• Threshold Manager cannot set thresholds on virtual ports of Centillion 
devices.

• Threshold Manager cannot set the following thresholds on Interfaces of 
Model 5616SA and Model 5310 NMMs and BayStack 200 and BayStack 
10BASE-T hubs:

— FCS Errors

— Collisions

— Late Collisions

— Short Events

— Rate Mismatches

— Back-off Failures

— Auto-partitions

— Short IPGs

— Null Frames

• When you set thresholds on a BayStack 200, the Target list contains the 
following backplane entries: 

— Unit <unit number> Backplane 1

— Unit <unit number> Slot <slot number> Backplane 1 

Only the entry for Unit <unit number> Slot <slot number> Backplane 1 is 
valid; thresholds set for the other entry will not work.

• When you set thresholds for a BayStack 350 with version 2.0 agent, you must 
set both rising and falling thresholds.
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• The following error messages from Threshold Manager are not documented.

Apply to device operation failed on x entries. (THD-045)

Please select an available board for the filter! (THD-046)

Please select an available interface for the filter! (THD-047)

Please select an available cluster for the filter! (THD-048)

Please select an available port for the filter! (THD-049)

Please select an available backplane for the filter! (THD-050) 

Bugs Fixed

• Threshold Manager™ now supports BayStack 28000 and BayStack 58000 
Series switches when you use agent version 2.0 or later.

Hard-Copy Technical Manuals

You can print selected technical manuals and release notes free, directly from the 
Internet. Go to support.baynetworks.com/library/tpubs/. Find the product for 
which you need documentation. Then locate the specific category and model or 
version for your hardware or software product. Using Adobe Acrobat Reader, you 
can open the manuals and release notes, search for the sections you need, and print 
them on most standard printers. You can download Acrobat Reader free from the 
Adobe Systems Web site, www.adobe.com.

You can purchase selected documentation sets, CDs, and technical publications 
through the collateral catalog. The catalog is located on the World Wide Web at 
support.baynetworks.com/catalog.html and is divided into sections arranged 
alphabetically: 

• The “CD ROMs” section lists available CDs.

• The “Guides/Books” section lists books on technical topics.

• The “Technical Manuals” section lists available printed documentation sets. 
896-007-N 41

http://support.baynetworks.com/library/tpubs
http://www.adobe.com
http://support.baynetworks.com/catalog.html


Release Notes for Optivity Campus 7.0.2

book.fm  Page 42  Monday, November 8, 1999  2:36 PM
How to Get Help

If you purchased a service contract for your Nortel Networks product from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact one of the following 
Nortel Networks Technical Solutions Centers:

How to View Optivity Campus Documents

To use the Optivity Campus 7.0.2 Documentation CD:

1. Insert the Optivity Campus 7.0.2 Documentation CD in the management 
station CD-ROM drive.

2. From the Windows Start menu, choose Run.

The Run dialog box opens.

3. Type the following:

<CDROM_drive>:\Welcome.pdf

4. Click OK.

The Optivity Campus 7.0.2 Documentation CD interface opens in Adobe 
Acrobat.

5. Click Main Menu.

The list of documentation opens.

6. Click the document that you want.

Technical Solutions Center Telephone Number

Billerica, MA 800-2LANWAN (800-252-6926)

Santa Clara, CA 800-2LANWAN (800-252-6926)

Valbonne, France 33-4-92-96-69-68

Sydney, Australia 61-2-9927-8800

Tokyo, Japan 81-3-5402-7041
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